
Welcome to emWave® 
 

emWave Pro Tour 
The following tour will give you an overview of the features in emWave Pro software. It also describes 
how to connect the hardware and how to interpret the feedback. 

After installing, follow these steps: 

  

1. Review the Quick Coherence Tutorial and familiarize yourself with the Quick 
Coherence® Technique. 

Before using the emWave software it is highly 
recommended that you learn or review the 
Quick Coherence technique. 

The Quick Coherence Technique helps you 
create a coherent state that uses the power of 
your heart to balance your thoughts and 
emotions, helping you to achieve a neutral, 
poised state for clear thinking. It is a powerful 
technique that helps you release stress, 
balance your emotions and feel better fast. You 
will be able to see your heart rhythms change 
as you become coherent using the emWave 
software. 

  

 

2. User Accounts and HeartCloud  

When you first install the software you are prompted to set up your first Users profile. At that time you 
would have been asked "Would you like to set up a HeartCloud Account?" 

If you answered no, you can still set up your user to Sync to HeartCloud from the icon on the 
Progress View. 

Setting up an account will enable you to synchronize session data across all your devices, earn 
trophies and receive helpful tips on training! 

For more information on HeartCloud click here: HeartCloud Tour 

  

http://www.heartmath.com/quick-coherence-technique/
http://my.emwave.com/library/heartcloud_tour.html


3. Plug the USB module into a USB port on your computer 

Connect the sensor cable to the USB module and plug it into an available USB port on your 
computer. Make sure the sensor cable is securely connected to the USB module. Ensure that the 
post on the sensor cable is fully inserted into the USB module and that the USB module is also 
securely plugged into a USB port on your computer. 

 

Immediately after the emWave Module is connected to a USB port, 3 lights (Red, Green, Blue) at the 
end next to the sensor plug will quickly flash indicating a successful internal test. If these lights do not 
flash, your Module may not be recognized. If so, try unplugging and reconnecting or try a different 
USB port on your computer. 

  

4. Connect the ear sensor to your ear 

 

Remove any earrings (if applicable) and clip the ear sensor to your earlobe and the lapel clip to your 
clothing. Slide the lapel clip along the wire to a comfortable position. You might have to reposition the 
sensor on your ear to get accurate pulse detection. The ear sensor should be attached directly to 
your earlobe. The ear sensor detects your pulse more easily if your ear is warm. You can warm your 
ear by briefly holding it with your warmed fingers before clipping on the sensor. 

  



5. Start a session and confirm an accurate pulse is being collected 

After properly connecting the ear sensor, click the Start icon located at the bottom of the 
screen. 

For best results getting a reading, please be still and quiet. Talking or moving reduces the accuracy of 
the sensor. Taking a few deep breaths before attaching the ear sensor may help you to relax and get 
a good reading. If you are seeing red lines (artifacts) in your heart rhythm pattern, adjust your sensor 
until your pulse wave data shows distinct, smooth wave forms. You may need to move the sensor to 
another part of your earlobe to get a good reading. After repositioning the ear sensor, it may take a 
few seconds to register your pulse. 

To stop the session simply click the Stop icon  

After stopping your session your data is automatically saved. 

  

6. Record Session View  

The toolbar at the top of the screen includes icons as described below: 

 

• On the left two pull down menus allow you to:  
o Select, edit or add a user. 

NOTE: At the bottom of the drop menu, we have provided — Done. This feature is 
provided for practitioners to avoid recording for the wrong user. If you always set it to 
Done when you're finished, the next user won't be able to record a session (or view 
sessions) until a user has been selected. 

o Specify the challenge level and set default challenge level 
• The center contains the icons which switch between the three views:  

o Review Progress  
o Record Session  
o The Balloon Icon launches the menu to access Games, Coach, My Inspiration and 

Visualizers 

On the right there are six more icons that are described below, press once to open: 

o HeartCloud– is available if you have a HeartCloud user account set up, you are logged 
in and you have internet connectivity. 

o Mandala 
o Journals 
o Session Information 
o Library Window 
o Help Window 



The bottom status bar displays session information: 

 

o Your Cumulative Coherence Ratios for the session in a color bar 
o The Coherence Score 
o Achievement Score. This is the sum of your individual Coherence Scores during the 

length of a session. 
o The session time 
o Your current heart rate will display while you are running a session and your average 

heart rate will display when you press stop 

In addition there are control icons: 

o Start session 
o Stop the session 
o Sound On/Off  

Note: You can also change, enable or disable your sounds and their relative volume in the 
Preferences panel. 

The application will always open ready to record a session. 
After the sensor has calibrated your pulse, the following screen shows your session in Record Mode. 
This window is divided into several panes displaying different graphs and information of your current 
session, either while recording or reviewing. 

 



The top graph is reserved for displaying Heart Rate Variability, or HRV. 

The bottom left and right views can be set to display the following: 

o Accumulated Score displays the Accumulated Coherence or Zone score once you are 
in session. This is a measure of how well you have done over the session. 

o Spectrum Average (available while reviewing a Session) 
o Power Spectrum (available while running a Session) 

NOTE: For additional information on interpreting the Power Spectrum, please see the 
emWave Help File in the emWave program. 

o Coherence Ratio displays on the bottom right. This is a summary of the amount of time, 
as a percentage of the total session length, in each of the three Challenge Level ranges. 
This score will be affected by your challenge level settings.  

o Pulse 

The Breath Pacer appears to the right of the HRV display. 

 

 

 

o You can toggle the Pacer display through the View menu by selecting Show Breath 
Pacer or Hide Breath Pacer. If you prefer you may use the shortcut keys. On Windows, 
press the Control key, Alt, and the letter P. On Mac, press the Command key, Option, 
and the letter P.  

o The default breath cycle time is 10 Seconds. To increase the cycle time of the pacer 
while running a session, press the + icon in the pacer. To decrease the cycle time, 
press the - icon.  

o You can see your cycle time on the User tab in the Inspector. If you hover your mouse 
pointer over the time in the Inspector, it says "Press to reset" where you can set a 
comfortable pace.  

o The cycle time settings are saved for each user.  



Mandala 

The Mandala will launch by default when you start a session. To manually open and close the 
Mandala panel, you can toggle it from the View menu or by simply pressing the letter M on your 
keyboard. 

 

You can change the default view for the Mandala in the Preference settings. You can choose to 
enable or disable the feature: Always Open Mandala 

To edit the speed of the Mandala's breath pacer, go to the User tab (next to the Session tab on the 
right). 

 



Click on the Breath Cycle Time in bold. 
A small window comes up that allows you to adjust the breathing pace.  

 

Click the up/down arrow to adjust the breathing pace to your comfort. 
Note: Increasing the time will add time to the length of each cycle. This is available even while 
running a session!  

Breathe in and out with the Mandala to improve the inner balance between your mind and heart! 
Please note that the Mandala is not available on older Operating Systems including Windows XP and 
Snow Leopard. 

7. Review Your Progress 

Selecting the  icon on the toolbar shows you the "Review Progress" view where there is a 
summary of all your sessions. You can mouse over the sessions, and the bottom status bar will show 
a summary of each session and the information on the right of the screen will give you the date, time, 
level and journal entry for the session. 

 



Double clicking on a session will open it in the detail view. You can "Replay the Session" by clicking 
on Replay HRV Session located in the Run menu. 

Coherence Building Tools - Games, Coach, My Inspiration and Visualizers 

To enhance your training experience and make it more fun, you can select the balloon icon 

on the toolbar to see the coherence building tools and games. 

This screen shows you the available coherence training options within the application. Clicking on the 
individual item will open that option. 

 

Once you are running a coherence building tool, you can switch back and forth between windows. 
However, if you start your recording from the session view, you cannot start a coherence building 
tool. To run one of these options you must start the session from the tool view. 

After a session has completed, return to the standard session window by clicking the  icon. 

  

 

 

 



My Inspiration 

For a personalized way to reach coherence, you can add your own pictures and music that help you 
reach coherence. 

 

To add your pictures: 
From the View menu, choose Media Folder. Copy your inspirational images to this location. File types 
that you can view include jpg, bmp and gif file formats. 

To add your music: 
Here you can preview and select the Sound files you want to play. You can also enable a soundtrack 
to play during your session. Most of the games play with music so these sounds will be muted when 
running a game. The My Inspiration Game can use a custom soundtrack. Click on the soundtrack 
icon, where the default soundtrack is 7 minute song.mp3 and browse your computer's music files until 
you find the song you are looking for. The music file must be in the MP3, WAV or WMA audio format 
to run. Click on it to load it into emWave. Once you have uploaded your song, click on the enable box 
and click Preview to confirm that the music will play. Once this is done, click on OK to close the 
menu. Alternatively, you can also play music in the background using another application (iTunes, 
Windows Media Player, etc.) without needing to use the emWave application to play the music. 

Now that you have added your pictures and music, attach your ear or finger sensor and click on the 
start icon. 

 

 



Coherence Coach® 

The Coherence Coach teaches you the Quick Coherence Technique through guided instruction.  

A great place to start is with the Coherence Coach. 

 

HRV 

Viewing your heart rhythm pattern during a session will show you a great deal about your internal 
physiological state. It contains a tremendous amount of information about the constantly changing 
state of your autonomic nervous system. Ultimately the heart rhythm pattern itself offers you even 
more information than your numerical Accumulated Coherence Score. 

With regular use, you will be able to look at your heart rhythm pattern displayed within the HRV 
Graph, and visually identify when you are in low, medium or high coherence. With time, you will be 
able to recognize your coherence patterns. A nice, smooth, coherent heart rhythm pattern looks 
similar to the image in Example 1: 

 
Example 1: Nice Smooth Coherent Heart Rhythm Pattern 



In many situations, good physiological coherence will not result in this exact waveform. It may look 
more like the graph below in Example 2. 

 
Example 2: A Coherent Heart Rhythm Pattern  

A coherent heart rhythm pattern is easy to distinguish from a pattern that is incoherent. 

 
Example 3: An Incoherent Heart Rhythm Pattern  

As you practice the Quick Coherence technique and become more coherent, the line should gradually 
change from an incoherent pattern to a coherent pattern. 

 

Coherence Ratios 

The coherence ratios present a continuously updated view of your physiological coherence ratios and 
current coherence score during a session. The information is updated every five seconds in 
correlation with your heart rhythm pattern. As the data is continuously added, the software averages 
the ratios and updates the graph throughout the session. After stopping the session or in Review 
Progress, the coherence ratios reflect the average ratios of coherence over the entire length of the 
session. 

 



The coherence ratio graph is divided into three coherence levels: low, medium and high coherence. 
The total of the low, medium and high coherence scores will always equal 100%.  

The coherence ratio bars show how much time you have spent in low, medium and high coherence 
during your session. The goal is to improve your ratio in medium and high coherence. With regular 
practice, your ratio in high coherence will improve and your ability to remain coherent when not 
recording a session will increase. 

The three coherence lights reflect your coherence score for the most current 5 seconds of data, and 
are updated every 5 seconds. 

 

In the image above you can see the amount of time spent in each coherence level. 

- Red is "Low Coherence" 
- Blue is "Medium Coherence" 
- Green is "High Coherence" 

Ideally, you will want to be in high coherence closer to 100% of the time, when there would be the 
most green visible. 

The heart rate display reflects the average heart rate for the most current 5 seconds of data. Every 5 
seconds the application averages your heart rate and displays that average. 

 

 

Once you end your session the average heart rate for the entire session is shown. 

Remember to improve your coherence ratios by practicing the Quick Coherence Technique, located 
in the Coherence section of this library. 

7. Review Your Saved Sessions 

The emWave software automatically saves the data from each session and allows you to review your 

progress. Click on the Review Progress  icon to see your saved sessions. 

To delete sessions, click on the Review Progress icon to see your saved sessions, select the session 
to be deleted (the session will appear) from the File menu. Select Delete Session. The selected 
Session is now permanently deleted. 

 
 
 



Journals  

On the Journal tab, you can add, edit or delete Journal entries to document your journey and moods. 
Use the + icon to add new entries. Click in the edit box to the right of your entry to add text. 

 

Choose the emoticon that matches your mood. If you do not select an emoticon, it will display as a 
gray icon. 

  

 

 

 

 

 

 

 

 



8. Preference Settings 

General 

General settings such as how often would you like to check for software updates, Mandala, Session 
Length and Enable Multiple Databases are found here: 

  

 

  

 

 

 

 

 

 

 

 

 



Sound 

Sound effects and soundtrack can be adjusted through the Preference menu located within the Edit 
menu. Here you may preview and select the Sound files you want to play indicating your coherence 
level, you can enable them individually, and control their relative volume. You may also elect to only 
play them when your coherence level has changed. If you choose to enable a soundtrack to play 
during your session, note that the games will turn off this soundtrack but the My Inspiration feature 
will use it. Some sound file formats may not be supported by this program. Click preview to make 
sure your sound will work.  

 

 

  

 

 

 

 

 

 

 

 



Advanced 

Advanced settings are found here. If you’re playing an external third party game you can enable TCP 
communication for that here. Also, if you find yourself logged out of HeartCloud, you may log back in 
here: 

 

 

 

For additional support, please see the HeartMath Knowledge Base at: 

Support: http://support.heartmath.com 

Copyright © 2016 HeartMath LLC. All rights reserved.  
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